RealPresence® Collaboration Server, Virtual Edition
Copyright© 2014, Polycom, Inc. All rights reserved. No part of this document may be reproduced, translated into another language or format, or transmitted in any form or by any means, electronic or mechanical, for any purpose, without the express written permission of Polycom, Inc.

6001 America Center Drive
San Jose, CA 95002
USA

**Trademarks**  Polycom®, the Polycom logo and the names and marks associated with Polycom products are trademarks and/or service marks of Polycom, Inc. and are registered and/or common law marks in the United States and various other countries.

![Polycom Logo](image)

All other trademarks are property of their respective owners. No portion hereof may be reproduced or transmitted in any form or by any means, for any purpose other than the recipient's personal use, without the express written permission of Polycom.

**End User License Agreement**  By installing, copying, or otherwise using this product, you acknowledge that you have read, understand and agree to be bound by the terms and conditions of the End User License Agreement for this product. The EULA for this product is available on the Polycom Support page for the product.

**Patent Information**  The accompanying product may be protected by one or more U.S. and foreign patents and/or pending patent applications held by Polycom, Inc.

**Open Source Software Used in this Product**  This product may contain open source software. You may receive the open source software from Polycom up to three (3) years after the distribution date of the applicable product or software at a charge not greater than the cost to Polycom of shipping or distributing the software to you. To receive software information, as well as the open source software code used in this product, contact Polycom by email at OpenSourceVideo@polycom.com.

**Disclaimer**  While Polycom uses reasonable efforts to include accurate and up-to-date information in this document, Polycom makes no warranties or representations as to its accuracy. Polycom assumes no liability or responsibility for any typographical or other errors or omissions in the content of this document.

**Limitation of Liability**  Polycom and/or its respective suppliers make no representations about the suitability of the information contained in this document for any purpose. Information is provided "as is" without warranty of any kind and is subject to change without notice. The entire risk arising out of its use remains with the recipient. In no event shall Polycom and/or its respective suppliers be liable for any direct, consequential, incidental, special, punitive or other damages whatsoever (including without limitation, damages for loss of business profits, business interruption, or loss of business information), even if Polycom has been advised of the possibility of such damages.

**Customer Feedback**  We are striving to improve our documentation quality and we appreciate your feedback. Email your opinions and comments to DocumentationFeedback@polycom.com.

**Polycom Support**  Visit the Polycom Support Center for End User License Agreements, software downloads, product documents, product licenses, troubleshooting tips, service requests, and more.
Contents

About This Guide ................................................................. 5
    Prerequisites ................................................................. 5
    Who Should Read This Guide? .............................................. 5
    How This Guide is Organized ............................................. 6

About the RealPresence® Collaboration Server, Virtual Edition System ...... 7
    Workstation Requirements .................................................. 9
    Windows 7™ Security Settings ............................................. 9
    Internet Explorer 8 Configuration ........................................ 11

First Time Install and Configure RealPresence Collaboration Server, Virtual Edition ......................................................... 14
    Deploy RealPresence Collaboration Server, Virtual Edition, through RealPresence Platform Director ........................................... 15
    Deploy RealPresence Collaboration Server, Virtual Edition, through the VMWare vSphere Client or the VMWare vCenter Client ......................................................... 16
    Install RealPresence Collaboration Server, Virtual Edition, through the VMware vSphere Client ......................................................... 16
    Configure Host Server through VMware vSphere Client ..................... 25
    Virtual Edition Host Server Hardware Profile .................................. 25
    CPU Reservations ............................................................. 26
    CPU Affinity ................................................................. 29
    RAM Allocation .............................................................. 30
    RAM Reservations ........................................................... 31
    Power on the Virtual Machine ................................................ 33
    Configure IP Manually through VMware vSphere Client ....................... 34
    Add the Configured RealPresence Collaboration Server, Virtual Edition, Instance in the RealPresence Platform Director ......................................................... 60
    Connect to MCU ................................................................ 61
    Default System Flags ........................................................... 62
About This Guide

This guide provides information to help you understand the RealPresence Collaboration Server, Virtual Edition Multipoint Control Unit (MCU), and provides information to perform following tasks:

- First Time Install and Configure RealPresence Collaboration Server, Virtual Edition
- Select Collaboration Server Web Client Language
- Start Conferences Using Default Profiles

The *RealPresence Collaboration Server, Virtual Edition Administrator’s Guide* provides more in-depth information on configuring and managing the system.

Prerequisites

This guide assumes the user has the following knowledge:

- Familiarity with Windows® XP, Windows® 7, and Windows® 8 operating systems and interface.
- Familiarity with 32-bit Microsoft® Internet Explorer® version 7, 8, 9, and 10.
- Basic knowledge of video conferencing concepts and terminology.
- Advanced knowledge of VMware vSphere and vCenter.

Who Should Read This Guide?

System administrators and network engineers should read this guide to learn how to properly install and set up Polycom Collaboration Server systems. Chairpersons and system operators should read this guide to learn how to use the RealPresenceCollaboration Server Web Client or RMX Manager to run conferences.

Chairpersons and Operators (users who start and manage conferences on the MCU) please read:

- About This Guide
- About the RealPresence® Collaboration Server, Virtual Edition System
- Select Collaboration Server Web Client Language
- Start Conferences Using Default Profiles

System Administrators please read:

- About This Guide
- About the RealPresence® Collaboration Server, Virtual Edition System
- First Time Install and Configure RealPresence Collaboration Server, Virtual Edition
- Select Collaboration Server Web Client Language
- Start Conferences Using Default Profiles
# How This Guide is Organized

The following typographic conventions are used in this guide to distinguish types of in-text information.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bold</strong></td>
<td>Highlights interface items such as menus, soft keys, flag names, and directories. Also used to represent menu selections and text entry to the Collaboration Server Web Client or the RMX Manager.</td>
</tr>
<tr>
<td><strong>Italics</strong></td>
<td>Used to emphasize text, to show example values or inputs, file names and to show titles of reference documents available from the Polycom Support Web site and other reference sites.</td>
</tr>
<tr>
<td><strong>Underlined Blue</strong></td>
<td>Used for URL links to external Web pages or documents. If you click on text in this style, you will be linked to an external document or Web page.</td>
</tr>
<tr>
<td><strong>Blue Text</strong></td>
<td>Used for cross referenced page numbers in the same or other chapters or documents. If you click on blue text, you will be taken to the referenced section. Also used for cross references. If you click the italic cross reference text, you will be taken to the referenced section.</td>
</tr>
<tr>
<td><code>&lt;variable name&gt;</code></td>
<td>Indicates a variable for which you must enter information specific to your installation, endpoint, or network. For example, when you see <code>&lt;IP address&gt;</code>, enter the IP address of the described device.</td>
</tr>
<tr>
<td><code>&gt;</code></td>
<td>Indicates that you need to select an item from a menu. For example, <strong>Administration &gt; System Information</strong> indicates that you need to select <strong>System Information</strong> from the <strong>Administration</strong> menu.</td>
</tr>
</tbody>
</table>
About the RealPresence® Collaboration Server, Virtual Edition System

RealPresence® Collaboration Server, Virtual Edition is an IP based MCU that can provide feature-rich and easy-to-use multipoint voice and video conferencing.

The RealPresence Collaboration Server, Virtual Edition meets International Telecommunication Union—Telecommunication Standardization Sector, (ITU-T, formerly CCITT) standards for multipoint multimedia bridging devices, and meets ETSI standards for telecommunication products. In addition, it has been designed in compliance with IETF (Internet Engineering Task Force).

The MCU can be used as a standalone device to run voice and video conferences or it can be used as part of a solution provided by Polycom. This solution may include the following components:

- Polycom® RSS™ 4000 or Polycom® RealPresence® Capture Server—provides one-touch recording and secure playback on telepresence and video conferencing systems, tablets and smartphones, or from your Web browser.
- Polycom® RealPresence® Distributed Media Application™ (DMA™) system—provides call control and MCU virtualization with carrier-grade redundancy, resiliency and scalability.
- Polycom® RealPresence® Resource Manager—centrally manages, monitors and delivers Cloud based Video as a Service (VaaS) and enterprise video collaboration.
- Polycom® RealPresence® Access Director™ (RPAD)—removes communication barriers and enables internal and external teams to collaborate more easily and effectively over video.
- Polycom® RealPresence® Platform Director™—deploys and licenses RealPresence platform virtual edition products.

The following diagram describes the multipoint video conferencing configuration with the RealPresence Collaboration Server, Virtual Edition as a standalone MCU system.
Multipoint video conferencing using a RealPresence Collaboration Server, Virtual Edition

The RealPresence Collaboration Server, Virtual Edition provides multipoint voice and video conferencing in a VMware environment and is easily deployed using RealPresence® Platform Director™.

The RealPresence Collaboration Server, Virtual Edition can be controlled through the LAN, by the RMX Web Client application, using Internet Explorer installed on the user's workstation or the RMX Manager application. The RMX Manager can control several MCUs. For more information about the RMX Manager, see RMX Manager Application in the RealPresence Collaboration Server, Virtual Edition Administrator’s Guide.
Workstation Requirements

The Collaboration Server Web Client and RMX Manager applications can be installed in an environment that meets the following requirements:

- **Minimum Hardware**—Intel® Pentium® III, 1 GHz or higher, 1024 MB RAM, 500 MB free disk space.
- **Workstation Operating System**—Microsoft® Windows® XP, Windows® 7 and Windows® 8.
- **Network Card**—10/100/1000 Mbps.
- **Web Browser**—32-bit Microsoft® Internet Explorer® Version 7, 8, 9, and 10.
- Collaboration Server Web Client and RMX Manager are optimized for display at a resolution of 1280 x 800 pixels and a magnification of 100%.

The following table lists the Web Browsers and Operating Systems with which the Collaboration Server Web Client and RMX Manager applications are supported.

**Collaboration Server Web Client/ RMX Manager Environment Interoperability**

<table>
<thead>
<tr>
<th>Web Browser</th>
<th>Operating System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internet Explorer 7</td>
<td>Windows Vista™ / Windows 7</td>
</tr>
<tr>
<td>Internet Explorer 8</td>
<td>Windows 7</td>
</tr>
<tr>
<td>Internet Explorer 9</td>
<td>Windows 7/ Windows 8</td>
</tr>
<tr>
<td>Internet Explorer 10*</td>
<td>Windows 8</td>
</tr>
</tbody>
</table>

**Windows 7™ Security Settings**

Before running the Collaboration Server Web Client or RMX Manager applications in Window 7 operation system or in other operation systems, following system factors need to be considered:

- In Windows 8, it is recommended to run Internet Explorer as an administrator by holding the shift key and right-clicking on the IE icon, and then select Run as Administrator.
- .Net Framework 2.0 is required and installed automatically.
- If ActiveX installation is blocked please see ActiveX Bypass in the *RealPresence Collaboration Server, Virtual Edition Administrator’s Guide*.
- The RMX Web Client does not support larger Windows text or font sizes. It is recommended to set the text size to 100% (default) or normal, otherwise, some dialog boxes may not appear properly. To change the text size, click Control Panel > Display.
  - For Windows XP, click the Appearance tab, select Normal for the Font size and click OK.
  - For Windows 7, click the Smaller - 100% option and click OK.
- When installing the RMX Web Client, Windows Internet Explorer > Internet Options > Security Settings must be set to Medium or less.
- It is not recommended to run Collaboration Server Web Client and Polycom Resource Manager applications simultaneously on the same workstation.
- If Windows 7 is installed on the workstation, protected mode must be disabled before downloading the software to the workstation. To disable protected mode:
  1. In the Internet Options dialog box, click the Security tab.
2  Clear the **Enable Protected Mode** check box for each of the following tabs:

- Internet
- Local intranet
- Trusted sites

3  After successful connection to Collaboration Server, the **Enable Protected Mode** check boxes can be selected to enable **Protected Mode** for the following tabs:

- Internet
- Local intranet
Internet Explorer 8 Configuration

When using Internet Explorer 8 to run the Collaboration Server Web Client or RMX Manager applications, it is important to configure the browser according to the following procedure.

To configure Internet Explorer 8:

1. Close all browsers running on the workstation.
2. Use the Windows Task Manager to verify that no iexplore.exe processes are running on the workstation. If iexplore.exe processes are found, end the process.
3. Open Internet Explorer but do not connect to the MCU.
4. In the Internet Explorer menu bar, select Tools > Internet Options.
5. In the Browsing history area of the General tab, click Delete button.

The Delete Browsing History dialog box is displayed.

6. In the Delete Browsing History dialog box, select the Temporary Internet files and Cookies check boxes, then click the Delete button.

The Delete Browsing History dialog box closes and the files are deleted.
7. Again, in the **Browsing history** field of the **General** tab, click **Settings** button. The **Temporary Internet Files and History Settings** dialog box is displayed.

8. In the **Temporary Internet Files and History Settings** dialog box, click the **View objects** button. The **Downloaded Program Files** folder containing the installed program files is displayed.
9  Delete the EMAClassLoader.dll file.
10 Close the Downloaded Program Files folder and the Temporary Internet Files and History Settings dialog box.
11 In the Internet Options dialog box, click the OK button to save the changes and close the dialog box.
First Time Install and Configure RealPresence Collaboration Server, Virtual Edition

You can deploy a RealPresence Collaboration Server, Virtual Edition, either through the Polycom RealPresence® Platform Director or through the VMWare vCenter/vSphere Client, then allocate licenses to the RealPresence Collaboration Server, Virtual Edition, through the RealPresence Platform Director.

Deploy through the **RealPresence Platform Director** using the procedures in the following sections:

- Deploy RealPresence Collaboration Server, Virtual Edition, through RealPresence Platform Director
- Configure Host Server through VMware vSphere Client
- Connect to MCU

Deploy through the **VMware vSphere Client** or **VMware vCenter Client** using the procedures in the following sections:

- Deploy RealPresence Collaboration Server, Virtual Edition, through the VMware vSphere Client or the VMware vCenter Client
- Configure Host Server through VMware vSphere Client
- Configure IP Manually through VMware vSphere Client
- Connect to MCU
Deploy RealPresence Collaboration Server, Virtual Edition, through RealPresence Platform Director

The RealPresence Platform Director provides the flexibility to deploy, license and monitor all virtual edition RealPresence products, including the RealPresence Collaboration Server, Virtual Edition, using general purpose hardware in a data center or in the cloud.

The RealPresence Platform Director is available at no charge from http://support.polycom.com.

To install the RealPresence Collaboration Server, Virtual Edition:

1. Deploy the RealPresence Platform Director in your VMWare environment.


   When creating the new instance in the RealPresence Platform Director, you can choose to configure a static IP address and assign it to the RealPresence Collaboration Server, Virtual Edition, or to assign a IP address to the RealPresence Collaboration Server, Virtual Edition, through a DHCP server.

   - If the static IP address is configured in the RealPresence Platform Director and assigned to RealPresence Collaboration Server, Virtual Edition, the DHCP function is turned off on the RealPresence Collaboration Server, Virtual Edition.

   - If the DHCP is selected in the RealPresence Platform Director, the DHCP server will assign an IP address to the RealPresence Collaboration Server, Virtual Edition. Meanwhile, the RealPresence Platform Director will learn the IP address by querying the VMWare.


For more information, refer to the RealPresence Platform Director System Administrator’s Guide.
Deploy RealPresence Collaboration Server, Virtual Edition, through the VMWare vSphere Client or the VMWare vCenter Client

The RealPresence Collaboration Server, Virtual Edition, is installed using the VMWare vSphere Client or VMWare vCenter Client.

Install RealPresence Collaboration Server, Virtual Edition, through the VMWare vSphere Client

Many of the configurations needed require detailed knowledge of VMware. It is highly recommended that the CPU and RAM configurations be performed by the VMware administrator only.

Preparations

The MCU can be installed from the OVA file once the following procedures are completed:

- **VMware vSphere Client** is installed on the local workstation. For more details see the VMware vSphere documentation.
- **VMware vSphere Server** is installed on a server.
- A login with sufficient permissions to install the OVA file is provided by the system administrator.
- The OVA file is downloaded from Polycom website.

The time on the server must be accurate. The MCU may fail to install or set up properly if the time on the ESXi host isn’t correct.

Install the OVA File

This section introduces procedures to install the OVA file.

To install the MCU from the OVA file:

1. On the Windows taskbar, click the Start button > Programs.
   a. If the VMware vSphere Client is displayed in the recently used programs list, click **VMware vSphere Client** in the list to start the application.
   Or
   b. Click All Programs > VMware > VMware vSphere Client.

   The VMware vSphere Client login window is displayed.
2 In the IP address / Name field, enter the IP Address or the name of the vSphere host.

3 Either enter your vSphere User Name and Password or select Use Windows sessions credentials.

4 Click Login.

The VMware vSphere Client is displayed.

5 In the Inventory Panel, select the Datastore that will be used to house the MCU.

6 On the vSphere Client menu, select File > Deploy OVF Template.
The **Deploy OVF Template** wizard opens to the **Source** page.

7. Click **Browse**.

The **Open** dialog box appears.
8 Browse to the OVA file.
9 Either double-click the OVA file or click the file, then right-click and select Open.
10 Click Next.

The OVF Template Details page is displayed.
11 Click Next.
The *Name and Location* page is displayed.

12 Optional. Change the name from the default is desired. If you decide not to change the name here, it is strongly advised not to change it later. Changing it later may cause datastore corruption.

13 Click **Next**.
The Disk Format page is displayed.

14 Select Thin Provision and then click Next.

*This Provision* is recommended as it conserves space. The other options will also work.

The Network Mapping page is displayed.
15 Select the appropriate network mappings and then click **Next**.
The Ready to Complete page is displayed.

16 Verify that the **Power on after deployment** check box is cleared.

17 Verify that all the desired settings are correct, then click **Finish**.

The vSphere Client deploys the OVF file.

When the deployment is complete the following window appears:

18 Click **Close**.
Configure Host Server through VMware vSphere Client

This section provides information about the minimum hardware requirements of host server for installing the RealPresence Collaboration Server, Virtual Edition, and also introduces following configurations procedures to meet the minimum hardware requirements:

- CPU Reservations
- CPU Affinity
- RAM Allocation
- RAM Reservations
- Power on the Virtual Machine

These manual configurations are not mandatory; however, not performing these manual configurations may result in degraded video and audio performance. These configurations may be performed later, but CPU reservations can only be done after shutting down the virtual machine.

**Note: Network Interface Card**
Depending on the environment, the virtual machine might need a Network Interface Card (NIC) from the host dedicated for the virtual machine. For more information, refer to your VMware administrator.

Virtual Edition Host Server Hardware Profile

The following table describes the minimum VM host deployment settings for an instance of the RealPresence Collaboration Server system, Virtual Edition. It also shows the typical performance capacities of that deployment.

**NOTE: Dedicated VM Server**
To maximize audio and video quality Polycom strongly recommends a dedicated VM server per RealPresence Collaboration Server.

### Deployment Settings - Minimum / Recommended

<table>
<thead>
<tr>
<th>Component</th>
<th>Minimum Deployment Settings</th>
<th>Recommended Deployment Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>vCPU</td>
<td>25000 MHz Reservation</td>
<td>90000 MHz Reservation</td>
</tr>
<tr>
<td>Memory</td>
<td>16 GB Reservation</td>
<td>16 GB Reservation</td>
</tr>
<tr>
<td>Storage</td>
<td>30 GB</td>
<td>30 GB</td>
</tr>
<tr>
<td>Performance</td>
<td>14 SD ports or 7 HD ports</td>
<td>60 SD ports or 30 HD ports</td>
</tr>
</tbody>
</table>

**NOTE: vCPU**
For Intel CPUs, when Hyper threading is enabled (recommended), the numbers above refer to logical cores (vCores) and not physical cores.

An example for a recommended deployment is a 32 logical cores machine at 2.9GHz.
Because of differences in hardware and VM environments, the performance information is provided for guidance purposes and does not represent a guarantee of any kind by Polycom.

**CPU Reservations**

CPUs should be reserved for the virtual machine to ensure that a sufficient number of CPUs will be available during high usage.

**Note: Allocate cores to virtual machine**

Do not allocate all the cores to the virtual machine. It is recommended that 2 cores remain unlocated, regardless of the number of cores present, how many licenses are purchased, and what other virtual machines will be present.
To reserve CPUs for the virtual machine:

1. In the VMware vSphere Client, right-click on the deployed MCU and then click Edit Settings...

The settings for the Virtual Machine are displayed.
2 Under the **Hardware tab**, click **CPUs**.

The CPU configuration is displayed.

3 Change the *Number of cores per socket* so that the *Total number of cores* reflects the capacity needed for the licenses purchased. Refer to following table for examples. For systems not listed, some experimentation might be needed.

### Number of Cores Required for Licenses Purchased

<table>
<thead>
<tr>
<th>Number of Licenses Purchased</th>
<th>Dual Intel E5-2690 32 cores</th>
<th>Dual Intel E5-2680 32 cores*</th>
<th>Dual Intel E5-2650 32 Cores*</th>
<th>Dual Intel E5-2620 24 Cores</th>
<th>Dual Intel X5660 24 Cores*</th>
</tr>
</thead>
<tbody>
<tr>
<td>5 ports</td>
<td>5</td>
<td>5</td>
<td>7</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>10 ports</td>
<td>10</td>
<td>11</td>
<td>14</td>
<td>16</td>
<td>16</td>
</tr>
<tr>
<td>15 ports</td>
<td>16</td>
<td>17</td>
<td>21</td>
<td>24</td>
<td>24</td>
</tr>
<tr>
<td>20 ports</td>
<td>21</td>
<td>23</td>
<td>29</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>25 ports</td>
<td>26</td>
<td>29</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>30 ports</td>
<td>32</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
</tr>
</tbody>
</table>

* These numbers are estimates. The number of cores assigned may need to be adjusted.
NOTE: Hyperthreading
These numbers assume that hyperthreading is enabled in the physical server’s BIOS. If hyperthreading is disabled, the above numbers should be divided by approximately 2.

NOTE: Over-allocation of cores
Do not over-allocate cores.

CPU Affinity
Specific CPUs should be assigned to the virtual machine to assure that they will be available during periods of high usage.

Guidelines:
- CPU core 0 should not be allocated. Host operating system performance may be affected if this core is assigned to the virtual machine.
- At least one other core should not be allocated, regardless of how many licenses are purchased.
- When possible, it is advised to allocate cores on one CPU. This will enhance performance by reducing CPU-to-CPU communication times.
- If other virtual machines are run on the server, the MCU does not require that the other virtual machines be allocated CPUs.

To set CPU affinity:
1. In the VMware vSphere Client, right-click on the deployed MCU and then click Edit Settings...

   The settings for the Virtual Machine are displayed.
2 Click the Resources tab.
The Resources tab is displayed.

3 Change the Hyperthreaded Core Sharing mode to Internal.

4 Select the specific CPU cores to be used. For example, if assigning 8 cores, enter, “8-15”.

5 Click OK.

**RAM Allocation**

16 GB of RAM need to be allocated to the virtual machine in order to assure optimal performance, regardless of the number of licenses purchased.
To allocate RAM for the virtual machine:

1. In the VMware vSphere Client, right-click on the deployed MCU and then click Edit Settings...

2. In Memory Size, allocate at least 16 GB.

3. Click OK.

**RAM Reservations**

16 GB of RAM need to be reserved for the virtual machine in order to assure optimal performance, regardless of the number of licenses purchased.
To reserve RAM for the virtual machine:

1. In the VMware vSphere Client, right-click on the deployed MCU and then click Edit Settings...

   ![VMware vSphere Client menu](image)

   The settings for the Virtual Machine are displayed.

2. Click the Resources tab.

   ![Virtual Machine properties window](image)

   The Resources tab is displayed.

3. Click Memory.

4. Adjust the Reservation slider so that at least 16 GB is allocated.

5. Click OK.
Power on the Virtual Machine

After changes are made, it will be necessary to power the virtual machine on.

To power on the virtual machine:

1. In the VMware vSphere Client, right-click on the deployed MCU and then click Power > Power On.

2. Wait 5 minutes.
   The MCU is powered on.

Note: Configure IP manually if DHCP is not supported
If the IP Address field is blank after the Virtual Machine has fully started, the most likely reason is that DHCP is not supported in your environment. In order to use the MCU, the networking information will need to be configured manually. For more information, Configure IP Manually through VMWare vSphere Client. If DHCP is supported in your environment and no IP Address is assigned, consult your network administrator.
Configure IP Manually through VMWare vSphere Client

When a DHCP is enabled for the vSphere server network, the MCU is automatically assigned an IP address. If an IP address is not automatically assigned, you must manually configure the network settings in order to use the MCU.


Note: IP configuration can disconnect the ongoing calls
This procedure can be run anytime the MCU is running. However, ongoing calls will be disconnected if this procedure is run while conferences are taking place.

Preparations

- Obtain from your network administrator the following information:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Local Network Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Management Network IP Address</td>
<td></td>
</tr>
<tr>
<td>Management Network Subnet</td>
<td></td>
</tr>
<tr>
<td>Management Network gateway</td>
<td></td>
</tr>
<tr>
<td>Hostname</td>
<td></td>
</tr>
<tr>
<td>Search domain</td>
<td></td>
</tr>
<tr>
<td>Primary DNS Server (Optional)</td>
<td></td>
</tr>
<tr>
<td>Secondary DNS Server (Optional)</td>
<td></td>
</tr>
<tr>
<td>Tertiary DNS Server (Optional)</td>
<td></td>
</tr>
</tbody>
</table>

To configure the network setup manually:

1. On the Windows task bar, click the Start button > Programs.
   a. If the VMware vSphere Client is displayed in the recently used programs list, click VMware vSphere Client in the list to start the application.
   or
   b. Click All Programs > VMware > VMware vSphere Client.

   The VMware vSphere Client login window is displayed.
2 In the *IP address / Name* field, enter the IP Address or the name of the *vSphere* host.

3 Either enter your *vSphere User Name* and *Password* or select *Use Windows sessions credentials*.

4 Click **Login**.

The **VMware vSphere Client** is displayed.

5 In the **vSphere client**, select the **MCU**.

6 Click the **Console tab**.
The **Console** screen appears.

7 Click in the console window.
   The mouse pointer disappears.

   **Note: Press Ctrl+Alt to regain the control of the mouse**
   At any time, control of the mouse can be regained by pressing Ctrl-Alt. Click in the **Console** screen again to be able to type there.

8 In the **localhost login** line, enter the default user name polycom, then press **Enter**.

9 In the **password** line, enter the default password polycom, then press **Enter**.

   **Note: Enter the user name and password in lower case**
   Both the default user name and password are lower case. This contrasts with the default user name and password for the **RealPresence Collaboration Server Web Client**, which use upper case.
The network setup menu is displayed.

Note: Management Network and Media and Signaling Network use the same IP
Both the Management Network and the Media and Signaling Network use the same IP setup information. Therefore, Media and signaling network setup is not required. Do not change the settings in the Media and signaling network setup.
10 Use the up and down arrows to select **Management network setup**, then press **Enter**.
11 Select the eth0 interface, and press Enter.

12 Optional. To set up static IP information:

**Note: Setting a static IP automatically disables DHCP**
Setting a static IP automatically disables DHCP.

**Note: Settings only take effect after you have returned to the console login screen**
These settings only take effect after you have returned to the console login screen.

- Select **Static address setup** and press Enter.
b In the IP address field enter the IP address for the management network.

c In the Subnet mask field enter the subnet mask for the IP address.

d In the Default gateway field enter the default gateway for the management network.

e Press the Tab key to select Save configuration, then press Enter.
The network service restarts.

When the network service finishes restarting, press **Enter**.
The console displays the current network setup.

![Network Setup Console](image)

### Press Enter.

The console returns to the **network setup menu**.

![Network Setup Menu](image)

13 **Optional.** To enable DHCP:

a. Select **Management network setup** and press Enter.

b. Select the **eth0** interface and press **Enter**.
c Select **Set DHCP on** and press **Enter**.
The network service restarts.
14 When the network service finishes restarting, press **Enter**.

The console returns to the **network setup menu**.

15 When the **MCU** service restarts, press **Enter**.

The console returns to the **network setup menu**.

16 Optional. To configure DNS settings:
a  Select **DNS setup** and press **Enter**.

The **DNS setup** menu is displayed.

```
Choose one of the following options
1. Set host name
2. Set search domain
3. Set DNS servers
4. View DNS configuration
5. Exit to main menu
```

b  Select **Set host name** and press **Enter**.
The **Host name setup** menu is displayed.

![Host name setup menu](image)

**c** Enter the desired host name and press **Enter**.
The **DNS setup** menu is displayed.

- Select **Set search domain** and press **Enter**.
The **Set search domain** menu is displayed.

```
Search domain setup

Configure search domain

Search domain: polycom.com.

< Save configuration >  < Cancel >
```

e Enter the search domain and press **Enter**.
The **DNS setup** menu is displayed.

Select **Set DNS servers** and press **Enter**.
The **DNS Server setup** menu is displayed.

![Image of DNS Server setup menu]

**g** Enter the DNS servers and press **Enter**.
The **DNS setup** menu is displayed.

 Verify that all settings are correct by selecting **View DNS configuration** and pressing **Enter**.
The **Current DNS setup** is displayed.

```
Hostname: localhost.localdomain
Search domain: polycom.com
Primary: 10.226.113.2
Secondary: 10.226.113.3
Tertiary: 
```

*Press Enter.*
The DNS setup menu is displayed.

To return to the network setup menu, select Exit to main menu and press Enter.

17 Optional. To allow remote access to the Network setup menu:
a  Select **SSH setup** and press **Enter**. The **SSH setup** menu is displayed.

![SSH setup menu](image)

b  Select **Enable SSH** and press **Enter**. The **sshD** service restarts.

![SSH service restarting](image)
The console returns to the **SSH setup** menu.

To return to the **network setup menu**, select **Exit to main menu**.

The console returns to the **network setup menu**.

**18 Optional.** To change the password used to access the **network setup menu**:

a. Select **Change password** and press **Enter**.
The **Password setup** prompt is displayed.

**b** Enter the new password

**c** Press the down arrow and reenter the new password and then press **Enter**.

The console reports that the password has changed.
The console returns to the network setup menu.

19 To exit the Management network setup, use the up and down arrows to select Exit, then either press Enter, or press Tab and then press Enter.

The Network setup menu asks if the soft_mcu service should be restarted.

20 Use the left and right arrow keys to select Yes, then press Enter.
The **MCU** service restarts.

![Restarting MCU service](image1)

The **Console** screen returns to the login prompt.

![Console login prompt](image2)
21 To re-enable the mouse, press Ctrl-Alt.

The MCU’s network settings are configured.
Add the Configured RealPresence Collaboration Server, Virtual Edition, Instance in the RealPresence Platform Director


For more information, refer to the RealPresence Platform Director System Administrator’s Guide.
Connect to MCU

If Windows 7 is installed on the workstation, Protected Mode must be disabled before connecting to the MCU. For more information, see Windows 7™ Security Settings.

1. Start the Collaboration Server Web Client application on the workstation.
   a. In the Web browser’s address line, enter the IP address of the MCU as assigned to it by the DHCP or as you assigned to it (if a DHCP is not configured in your environment) in the format: http://<MCU IP Address>.
   b. Click Enter.

The Collaboration Server Web Client Login screen is displayed.

Note: Solve the browser environment error

If the error “Browser environment error. Please close all the browser sessions” appears, close all the browser sessions, and reconnect to the MCU. If the error message appears again, either run the automatic troubleshooter utility or manually preform the suggested troubleshooting procedures.

2. In the Collaboration Server Web Client Login screen, enter the default Username (POLYCOM) and Password (POLYCOM) and click Login.
Default System Flags

By default, the following system flags are used to define the system behavior when defining and running conferences:

Default System Flag Settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description / Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conference ID Length (MCU)</td>
<td>The number of digits of the Conference ID to be assigned by the MCU.</td>
</tr>
<tr>
<td></td>
<td>Range: 2-16 (Default: 5)</td>
</tr>
<tr>
<td>Minimum Conference ID Length (User)</td>
<td>The minimum number of digits that the user must enter when manually assigning a numeric ID to a conference.</td>
</tr>
<tr>
<td></td>
<td>Range: 2-16 (Default: 4)</td>
</tr>
<tr>
<td>Maximum Conference ID Length (User)</td>
<td>The maximum number of digits that the user can enter when manually assigning a Numeric ID to a conference.</td>
</tr>
<tr>
<td></td>
<td>Range: 2-16 (Default: 8)</td>
</tr>
<tr>
<td>MCU Display Name</td>
<td>The MCU name is displayed on the endpoint’s screen.</td>
</tr>
<tr>
<td></td>
<td>Default name: (Blank)</td>
</tr>
<tr>
<td>Terminate Conference when Chairperson Exits</td>
<td>When Yes is selected (default), the conference ends when the chairperson exits even if there are other participants connected.</td>
</tr>
<tr>
<td></td>
<td>When No is selected, the conference automatically ends at the predefined end time, or when all the participants have disconnected from the conference.</td>
</tr>
<tr>
<td>Auto Extend Conferences</td>
<td>When Yes is selected (default), allows conferences running on the Collaboration Server to be automatically extended as long as there are participants connected and there are available resources.</td>
</tr>
<tr>
<td></td>
<td>The maximum extension time allowed by the MCU is 30 minutes.</td>
</tr>
</tbody>
</table>

Note: Selecting 2 digits limits the number of simultaneous ongoing conferences to 99.
Select Collaboration Server Web Client Language

By default, the Collaboration Server Web Client interface is displayed only in English. However, the system administrator can choose the languages available for selection on the Login screen. These languages are represented by flags.

To choose the languages for selection in the Login screen:

1. On the Collaboration Server menu, click Setup > Customized Display Settings > Multilingual Setting. The Select Language window is displayed as below:

![Select Language Window]

2. Click the check boxes of the languages, then click OK. If the selected language is not supported by the browser or the workstation Operating System, the Collaboration Server Web Client is displayed in English.

3. Log out and reconnect to the Collaboration Server. The Login screen will display the flags of the selected languages.

For more information see Multilingual Setting in the related Administrator’s Guide.
Start Conferences Using Default Profiles

In the Polycom RealPresence CloudAxis Solution, the conferencing parameters are defined in the RealPresence CloudAxis suite using its RealPresence Virtualization Manager (DMA) component.

Your RealPresence Collaboration Server, Virtual Edition, is shipped with default conference profiles, allowing you to immediately start conferences.

Predefined conference profiles are:

- Factory_Video_Profile: Immediately start standard ongoing AVC CP only conferences.
- Factory_SVC_Video_Profile: Immediately start standard ongoing SVC Only conferences
- Factory_Mix_Video_Profile: Immediately start a standard ongoing mixed AVC CP and SVC conference.

For information on how these profiles are applied to different conferencing entities as the default conferences, see Default Conferencing Settings.

Note: More options available to set up and dial in to a conference

You can set up a conference in many ways, such as using your own profiles, meeting rooms, entry queues, and reservations. The dialing strings vary per the conferencing methods, conferencing network, and participant end point types.

For more information, refer to your system’s Administrator’s Guide.
To start a New Conference using a default profile:

1. In the Conferences pane, click New Conference ( ).
   The New Conference—General dialog box opens.

2. Select a conference profile from the Profile drop-down list.

3. If you know the IP address of your participants, you can add them to your conference: click the Participants tab > New. Enter a name and the IP address for the participant and click OK.
   By default, the RealPresence Collaboration Server dials out to these specified participants when the conference starts.
   You can also send the meeting dialing string to your participants so they can dial in to the conference themselves. For more information, see Join a Conference Using Dialing Strings.

4. Click OK to accept default settings.

5. The conference starts immediately and appears in the Conferences list.
   Your meeting participants appear in the Participants pane.
Join a Conference Using Dialing Strings

When you set up a conference, you can add participants that the RealPresence Collaboration Server will dial out to when the conference starts. You can also send dialing strings to participants so they can dial in to the conference. Dialing string formats vary per different conferencing scenarios.

Example of dialing Strings for H.323 Participants (AVC CP Only and Mixed Conferences)

For H.323 participants, the dialing string can of the following formats:

- `<MCU Prefix in gatekeeper><Conference ID>
- `<MCU Signaling Host IP address>##<Conference ID>

If your conference has the following parameters:

- MCU Prefix in gatekeeper: 2014
- Conference ID: 43602
- MCU Signaling Host IP address: 172.21.126.100

H.323 participants can dial one of the following strings to join the conference:

- 201443602
- 172.21.126.100##43602

Example of dialing Strings for SIP Participants (All Conferences)

For SIP participants, the dialing string can be of the following formats:

- `<Conference routing name>@<MCU domain name>
- `<Conference routing name>@<MCU Signaling Host IP address>

If your conference has the following parameters:

- MCU Signaling Host IP address: 172.21.126.100
- Conference routing name: test_25248795
- MCU domain name: polycom.com

SIP participants can dial one of the following strings to join the conference:

Note: Starting from version 8.1

- A license is required for SVC conferencing.
- In mixed AVC/SVC conferences, participants with SVC-enabled endpoints and AVC endpoints can participate in the same conference.
Start Conferences Using Default Profiles

- test_25248795@polycom.com
- test_25248795@172.21.126.100

To view your conference ID:

» Conference IDs appear in the Conferences pane.

![Conferences pane with conference IDs](image1)

To view your MCU signaling host IP address or MCU prefix in gatekeeper:

1. In the RMX Management pane, click IP Network Services.
2. Your Signaling Host IP address and MCU Prefix in Gatekeeper appear in the IP Network Service row.

![IP Network Services pane with IP addresses](image2)

To view your conference routing name:

1. In the Conferences pane, right-click your conference and select Conference Properties.

![Conference Properties menu](image3)
2. Your routing name can be found in the General tab.
   You can also set your routing name when you create a conference. If not specified, the default routing name is the same as the Display Name.

Gathering Phase (AVC CP Only Conferencing)

The Gathering Phase of a conference is the time period during which participants are connecting to a conference. It is enabled by default for AVC CP only conferences.

During the Gathering Phase, a mix of live video from connected endpoints is combined with both static and variable textual information about the conference into a slide, which is displayed on all connected endpoints.
All connected participants are kept informed about the current conference status including names of connected participants, participant count, participant type (video/audio) etc. During the Gathering Phase, the audio of all participants can be heard, and the video of active speakers is displayed in the video windows as they begin talking.
Default Conferencing Settings

For RealPresence Collaboration Server Virtual Edition, the default pre-configured conferencing entities are set to CP and SVC Conferencing Mode, which allows the MCU users and participants to start CP and SVC ongoing conferences without further configuration.

Default Conferencing Entities

<table>
<thead>
<tr>
<th>Entity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Meeting Rooms</td>
<td>Conferences saved on the MCU without using resources. They are activated when the first participant dials in. There are four default Meeting Rooms ready for use: Name ID Maple_Room 1001 Oak_Room 1002 Juniper_Room 1003 Fig_Room 1004 • On RealPresence Collaboration Server Virtual Edition, each Meeting Room uses the default Conference Profile called Factory_Mix_Video_Profile set to mixed CP and SVC Conferencing Mode, running at 1920Kbps and has a default duration of one hour.</td>
</tr>
<tr>
<td>Conference Profile</td>
<td>Default Conference Profile Name: • Factory_Mix_Video_Profile on RealPresence Collaboration Server Virtual Edition A default Conference Profile is assigned to a new Conference, a new Meeting Room or a new Entry Queue to define its Conferencing Mode, conferencing parameters, such as line rate and video resolution. The Factory_Mix_Video_Profile contains mixed CP and SVC video parameters with a bit rate of 1920Kbps, Auto Layout and Polycom Skin. The Profile uses an IVR Service called Conference IVR Service. Including the default Conference Profile, the system is shipped with following three pre-configured factory Conference Profiles: • Factory_SVC_Video_Profile—Contains the parameters of an SVC conference. • Factory_Mix_Video_Profile—Contains the parameters of a mixed CP and SVC conference. • Factory_Video_Profile—Contains the parameters of a CP conference.</td>
</tr>
<tr>
<td>Conference IVR Service</td>
<td>The Conference IVR Service includes an optional video slide and all the voice messages played during the participant's connection process and during the conference. The Conference IVR Service contains a set of voice prompts in English and an optional video slide. It automates the participant's connection to a conference.</td>
</tr>
</tbody>
</table>
Using an Entry Queue enables one dial-in number to be used for all AVC-based connections. In the Entry Queue, AVC participants are prompted for information to enable routing to their destination conferences.

The default Entry Queue is also set to Ad Hoc conferencing which allows participants to start new conferences without prior definition by entering a Conference or Meeting Room ID that is not used by any ongoing conference currently running on the MCU. It uses an Entry Queue IVR Service called Entry Queue IVR Service.

The default Welcome Slide displayed at the participants endpoint upon connection to the Entry Queue and lists the default Meeting Rooms. The participant can select one of these Meeting Rooms or enter another ID to start a new conference.

If no Transit Entry Queue is defined, DefaultEQ is the default Transit Entry Queue. For more information of Entry Queue, refer to Entry Queues in related Administrator’s Guide.

### Entry Queue IVR Service

Includes all the voice messages and video slides used to guide AVC participants through their connection process to the MCU and route them to their destination conference.

Entry Queue IVR Service is the default Entry Queue IVR Service provided for the default Entry Queue.

<table>
<thead>
<tr>
<th>Entity</th>
<th>Description</th>
</tr>
</thead>
</table>
| Entry Queue (AVC endpoints) | Default Display Name: DefaultEQ  
Default ID: 1000  
Default Profile:  
Using an Entry Queue enables one dial-in number to be used for all AVC-based connections. In the Entry Queue, AVC participants are prompted for information to enable routing to their destination conferences.  
The default Entry Queue is also set to Ad Hoc conferencing which allows participants to start new conferences without prior definition by entering a Conference or Meeting Room ID that is not used by any ongoing conference currently running on the MCU. It uses an Entry Queue IVR Service called Entry Queue IVR Service.  
The default Welcome Slide displayed at the participants endpoint upon connection to the Entry Queue and lists the default Meeting Rooms. The participant can select one of these Meeting Rooms or enter another ID to start a new conference.  
If no Transit Entry Queue is defined, DefaultEQ is the default Transit Entry Queue. For more information of Entry Queue, refer to Entry Queues in related Administrator’s Guide. |
| Entry Queue IVR Service | Includes all the voice messages and video slides used to guide AVC participants through their connection process to the MCU and route them to their destination conference.  
Enter Queue IVR Service is the default Entry Queue IVR Service provided for the default Entry Queue. |